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Abstract

These Application Notes describe the procedures for configuring Session Initiation Protocol
(SIP) Trunking between service provider TalkTalk Business and Avaya IP Office Release
10.0.

TalkTalk Business SIP Trunk Service provides PSTN access via a SIP trunk between the
enterprise and the TalkTalk Business network as an alternative to legacy analog or digital
trunks. This approach generally results in lower cost for the enterprise.

Readers should pay attention to Section 2, in particular the scope of testing as outlined in
Section 2.1 as well as the observations noted in Section 2.2, to ensure that their own use cases
are adequately covered by this scope and results.

Information in these Application Notes has been obtained through DevConnect compliance
testing and additional technical discussions. Testing was conducted via the DevConnect
Program at the Avaya Solution and Interoperability Test Lab.
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1. Introduction

These Application Notes describe the procedures for configuring Session Initiation Protocol (SIP)
Trunking between TalkTalk Business and the Avaya IP Office solution. In the sample configuration,
the Avaya IP Office solution consists Avaya IP Office 500 V2 Release 10.0, Avaya embedded
Voicemail, Avaya IP Office Application Server (with WebRTC and one-X Portal services enabled),
Avaya Communicator for Windows (SIP mode), Avaya Communicator for Web, Avaya H.323,
Avaya SIP, digital and analog endpoints. The enterprise solution connects to the TalkTalk Business
network.

The TalkTalk Business referenced within these Application Notes is designed for business
customers. The service enables local and long distance PSTN calling via standards-based SIP trunks
as an alternative to legacy analog or digital trunks, without the need for additional TDM enterprise
gateways and the associated maintenance costs.

2. General Test Approach and Test Results

The general test approach was to configure a simulated enterprise site using Avaya IP Office
connecting to TalkTalk Business.

This configuration (shown in Figure 1) was used to exercise the features and functionality tests
listed in Section 2.1. Note: NAT devices added between Avaya IP Office and the TalkTalk Business
network should be transparent to the SIP signaling.

DevConnect Compliance Testing is conducted jointly by Avaya and DevConnect members. The
jointly-defined test plan focuses on exercising APIs and/or standards-based interfaces pertinent to
the interoperability of the tested products and their functionalities. DevConnect Compliance Testing
is not intended to substitute full product performance or feature testing performed by DevConnect
members, nor is it to be construed as an endorsement by Avaya of the suitability or completeness of
a DevConnect member’s solution.

Avaya recommends our customers implement Avaya solutions using appropriate security and
encryption capabilities enabled by our products. The testing referenced in this DevConnect
Application Note included the enablement of supported encryption capabilities in the Avaya
products. Readers should consult the appropriate Avaya product documentation for further
information regarding security and encryption capabilities supported by those Avaya products.

Support for these security and encryption capabilities in any non-Avaya solution component is the
responsibility of each individual vendor. Readers should consult the appropriate vendor-supplied
product documentation for more information regarding those products.
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2.1. Interoperability Compliance Testing

A simulated enterprise site with Avaya IP Office was connected to TalkTalk Business. To verify SIP
trunking interoperability, the following features and functionality were exercised during the
interoperability compliance test:

e Incoming PSTN calls to various phone types. Phone types included Avaya H.323, Avaya
SIP, digital, and analog telephones at the enterprise. All inbound PSTN calls were routed to
the enterprise across the SIP trunk from the service provider

e Outgoing PSTN calls from various phone types. Phone types included Avaya H.323, Avaya
SIP, digital, and analog telephones at the enterprise. All outbound PSTN calls were routed
from the enterprise across the SIP trunk to the service provider

e Inbound and outbound PSTN calls from/to the Avaya Communicator for Windows (SIP
mode)

e Inbound and outbound PSTN calls from/to the Avaya Communicator for Web with basic
telephony transfer feature

e Inbound and outbound long hold time call stability

e Various call types including: local; long distance; international call; inbound toll-free;

outbound toll-free; outbound to assisted operator 100, local directory assistance 118138; and
emergency call 999 during the compliance testing

SIP transport using UDP as supported by TalkTalk Business

Codec G.711A, G.711MU

Caller number/ID presentation

Privacy requests (i.e., caller anonymity) and Caller ID restriction for inbound and outbound
calls

DTMF transmission using RFC 2833

Voicemail navigation for inbound and outbound calls

Telephony features such as hold and resume, transfer, and conference

Fax G.711 pass-through mode

Use Party Asserted Identity (PAI)/Diversion header in off-net call forwarding

Use SIP re-Invite in off-net call transfer

Twinning to mobile phones on inbound calls

Item not supported by TalkTalk Business LAB environment include the following:
e TLS/SRTP
e FaxT.38
e SIP Refer in off-net call transfer

HV; Reviewed: Solution & Interoperability Test Lab Application Notes 3 of 37
SPOC 6/7/2017 ©2017 Avaya Inc. All Rights Reserved. TTB-IPO10



2.2. Test Results

Interoperability testing of TalkTalk Business was completed with successful results for all test cases
with the exception of the observation described below:

1. By default, TalkTalk Business’s network does not send the SIP OPTION to CPE unless the
trunk failover is purchased. During the compliance testing, TalkTalk Business turned it on so
that the SIP OPTION was sent to Avaya IP Office every 60 seconds

2. For anonymous outbound call, TalkTalk Business request to see privacy id with the trusted
Calling Line Identification Display (CLID) in the PAI header, otherwise TalkTalk Business
will not authenticate the call and it will be rejected with a “603 Declined”

3. For off-net forward call, TalkTalk Business request to see the trusted CLID number in the
PAI header (or Diversion header CLID copied to PAI header) rather than the originating
CLID number, otherwise TalkTalk Business will not authenticate the call and it will be
rejected with a “603 Declined”

4. For off-net transfer call, TalkTalk Business request to see the trusted CLID number in the
PAI header rather than the originating CLID, otherwise TalkTalk Business will not
authenticate the call and it will be rejected with a “603 Declined”

2.3. Support

For technical support on the Avaya products described in these Application Notes visit:
http://support.avaya.com

For technical support on TalkTalk Business SIP Trunking, contact TalkTalk Business at
https://www.talktalkbusiness.co.uk/products/voice/
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3. Reference Configuration

Figure 1 below illustrates the test configuration. The test configuration shows an enterprise site
connected to TalkTalk Business through the public IP network. For confidentiality and privacy
purposes, actual public IP addresses used in this testing have been masked out and replaced with
fictitious IP addresses throughout the document.

The Avaya components used to create the simulated customer site included:
Avaya IP Office 500 V2

Avaya embedded Voicemail for IP Office

Avaya Application Server (Enabled WebRTC and one-X Portal services)
Avaya 9600 Series IP Deskphones (H.323)

Avaya 11x0 Series IP Deskphones (SIP)

Avaya 1408 Digital phone

Avaya Analog phone

Avaya Communicator for Windows (SIP)

Avaya Communicator for Web

Located at the enterprise site is an Avaya IP Office 500 V2 with the MOD DGTL STAL16 expansion
module which provides connections for 16 digital stations to the PSTN, and the extension PHONE 8
card which provides connections for 8 analog stations to the PSTN as well as 64-channel VCM
(Voice Compression Module) for supporting VVolP codecs. The voicemail service is embedded on
Avaya IP Office. The LAN2 port of Avaya IP Office is connected to the public IP network.
Endpoints include Avaya 9600 Series IP Telephone (with H.323 firmware), Avaya 1100 Series IP
Telephone (with SIP firmware), Avaya 1408D Digital Telephone, Avaya Analog Telephone, and
Avaya Communicator for Windows. The LANL1 port of Avaya IP Office is connected to the
enterprise LAN (private network) while the LAN2 port is connected to the public network.

A separate Windows 10 Enterprise PC runs Avaya IP Office Manager to configure and administer
the Avaya IP Office system.

Mobility Twinning is configured for some of the Avaya IP Office users so that calls to these user’s
phones will also ring and can be answered at configured mobile phones.
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Figure 1 - Test Configuration for Avaya IP Office with TalkTalk Business SIP Trunk Service

For the purposes of the compliance test, Avaya IP Office users dialed a short code of 9 + N digits to
send digits across the SIP trunk to TalkTalk Business. The short code of 9 was stripped off by Avaya
IP Office but the remaining N digits were sent unaltered to the TalkTalk Business system. For calls
within the North American Numbering Plan (NANP), the user would dial 13 (001 + 10) digits. Thus
for these NANP calls, Avaya IP Office would send 13 digits in the Request URI and the To field of
an outbound SIP INVITE message. It was configured to send 11 digits in the From field. For
inbound calls, TalkTalk Business sent 11 digits in the Request URI and the To field of inbound SIP
INVITE messages.

In an actual customer configuration, the enterprise site may also include additional network
components between the service provider and the Avaya IP Office such as a session border
controller or data firewall. A complete discussion of the configuration of these devices is beyond the
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scope of these Application Notes. However, it should be noted that SIP and RTP traffic between the
service provider and the Avaya IP Office must be allowed to pass through these devices.
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4. Equipment and Software Validated

The following equipment and software/firmware were used for the sample configuration provided:

Avaya Telephony Components

Equipment

Release

Avaya IP Office solution
= Avaya IP Office 500V2
Embedded Voicemail
Avaya Web RTC Gateway
Avaya one-X Portal
Avaya IP Office Manager
Avaya IP Office Analogue PHONE 8
Avaya IP Office VCM64/PRID U
Avaya IP Office DIG DCPx16 V2

10.0.0.3.0 build 5
10.0.0.3.0 build 5
10.0.0.3.0 build 10
10.0.0.3.0 build 9
10.0.0.3.0 build 5
10.0.0.3.0 build 5
10.0.0.3.0 build 5
10.0.0.3.0 build 5

Avaya 1140E IP Deskphone (SIP) 04.04.23
Avaya 9641G IP Deskphone 6.6.3.02_ V474
Avaya 9621G IP Deskphone 6.6.3.02_ V474
Avaya Communicator for Windows (SIP) 2.1.3.237
Avaya Communicator for Web 1.0.16.1718
Avaya 1408D Digital Deskphone R46

Avaya Analog Deskphone N/A

HP Officejet 4500 (fax) N/A

TalkTalk Business Components

Equipment

Release

Asterisk softswitch

1.8.9.3

Kamailio SIP Server

4.2

Note: Compliance Testing is applicable when the tested solution is deployed with a standalone IP
Office 500 V2 and also when deployed with IP Office Server Edition in all configurations.
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5. Configure Avaya IP Office Solution

This section describes the Avaya IP Office solution configuration necessary to support connectivity
to the TalkTalk Business. It is assumed that the initial installation and provisioning of the Avaya IP
Office 500 V2 has been previously completed and therefore is not covered in these Application
Notes. For information on these installation tasks refer to Additional References Section 9.

This section describes the Avaya IP Office configuration to support connectivity to the TalkTalk
Business system. Avaya IP Office is configured through the Avaya IP Office Manager PC
application. From a PC running the Avaya IP Office Manager application, select Start - Programs
—> IP Office = Manager to launch the application. Navigate to File > Open Configuration, select
the proper Avaya IP Office system from the pop-up window and click OK button. Log in using
appropriate credentials.

"
File Edit View Tools Help

R BOOTP (5)
¢ Operator (3)

B Select IP Office = m] X

Name IP Address  Type Version Edition
Release 10.0
l IPOffice_1 10.10.98.14  IP500V2 10.0.0.3.0build 5 IP Office

TCP Discovery Progress

Unit/Broadcast Address

10.1098.14 < Refresh Cancel

Figure 2 — Avaya IP Office Selection
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5.1. Licensing

The configuration and features described in these Application Notes require the Avaya IP Office
system to be licensed appropriately. If a desired feature is not enabled or there is insufficient
capacity, contact an authorized Avaya sales representative.

To verify that there is a SIP Trunk Channels license with sufficient capacity, select IPOffice_1 -
License on the Navigation pane and SIP Trunk Channels in the Group pane. Confirm that there is a
valid license with sufficient “Instances” (trunk channels) in the Details pane.

IP Offices | License
R BOOTP (5) License Type ~ Status License Remote Server
4 Operator (3)
=-*39|IPOffice_1 License Mode License Normal
9 System (1) . .
1 Line (4) Licensed Version 10.0

=2 Control Unit (4) PLDS Host ID 111316612166

4 Extension (40)

§ User34) PLDS File Status ~ Valid
% Group (1) )
g ghor.t Co(;ie (60) Feature Instances Status Expiration Date Source )
& ReAr;I(CG( ; Receptionist 4 Valid Never PLDS Nodal
e Incoming Call Route (14) Additional Voicemail Pro Ports 152 Valid Never PLDS Nodal
€2 WAN Port (0) VMPro Recordings Administrators 1 Valid Never PLDS Nodal
= ?ii::t;zfgloe] - Essential Edition Additional Voice... 4 Valid Never PLDS Nodal
‘@ Firewall Profile (1) VMPro TTS (Generic) 40 Valid Never PLDS Nodal
IP Route (2) Teleworker 384 Valid Never PLDS Nodal
#m Account Code (0) Mobile Worker 384 Valid Never PLDS Nodal
L I License (31) Office Worker 384 Valid Never PLDS Nodal
w T“""e_l © Avaya Softphone Licence 100 Valid Never PLDS Nodal
& k) " VMPro TTS (Scansoft) 2 Valid Never PLDS Nodal
“¢ ARS (1) VMPro TTS Professional 40 Valid Never PLDS Nodal
&5 Location (0) IPSec Tunnelling 1 Valid Never PLDS Nodal
ﬁ Authorization Code (0) Power User 384 Valid Never PLDS Nodal
Avaya IP endpoints 384 Valid Never PLDS Nodal
IP500 Voice Networking Channels 32 Valid Never PLDS Nodal
SIP Trunk Channels 128 Valid Never PLDS Nodal
IP500 Universal PRI (Additional cha... 100 Valid Never PLDS Nodal
CTl Link Pro 1 Valid Never PLDS Nodal
Wave User 16 Valid Never PLDS Nodal
3rd Party IP Endpoints 384 Valid Never PLDS Nodal
Essential Edition 1 Valid Never PLDS Nodal <

Figure 3 — Avaya IP Office License
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5.2. System Tab

Navigate to System (1) under the IPOffice_1 on the left pane and select the System tab in the
Details pane. The Name field can be used to enter a descriptive name for the system. In the reference
configuration, IPOffice_1 was used as the name in IP Office.

IP Offices \ System IPOffice_1 o v

& BOOTP (5) Hame LANT LAN2 DNS  Voicemail Telephony Directory Services SystemEvents SMTP SMDR VCM  VolP  VolP Security Contact < |*

¢+ Operator (3) =% IPOffice_1 A
- [IPOffice_1 ‘Name IPOffice_1 | Locale United States (US English) v
i System (1)

T4 Line (4) Location <None> v
= Control Unit (4)

4 Extension (40)

§ User3y Set contact information to place System under special control

2% Group (1)

9% Short Code (60)

@ Service (0)

ok RAS (1)

Contact Information

@ Incoming Call Route (14)
€9 WAN Port (0)

£ Time Profile (0)
@ Firewall Profile (1) TFTP Server IP Address 255 255 255 255

K@ 1P Route (2)

am Account Code (0) HTTP Server IP Address 0 0 0 0
,:; #::::((03)1) Phone File Server Type Memory Car v HTTP Redirection | Off <
&3 User Rights (9) Manager PC IP Address 255 . 255 . 255 . 255
8 Auto Attendant (0)
‘€ ARS (1) Avaya HTTP Clients Only =
; ;cuct:t;::a(t?)on T Enable Softphone HTTP Provisioning [ Favor RIP Routes, over static routes
Automatic Backup
Time Setting Configuration Source Voicemail Pro/Manager v
Time Settings
Time Server Address 0 0 0 0

Time Offset (hh:mm) 00:00 |

File Writer IP Address 10 10 98 79 v
< >

Figure 4 - Avaya IP Office System Configuration
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5.3. LAN2 Settings
In the sample configuration, LANZ is used to connect the enterprise network to the TalkTalk
Business network.

To configure the LAN2 settings on the IP Office, complete the following steps. Navigate to
IPOffice_1 - System (1) in the Navigation and Group Panes and then navigate to the LAN2 -
LAN Settings tab in the Details Pane. Set the IP Address field to the IP address assigned to the
Avaya IP Office LAN2 port. Set the IP Mask field to the mask used on the public network. All other
parameters should be set according to customer requirements. Click OK to submit the change.

IP Offices System =g IPOffice_1* ( v |
& gomf (5(’3) Name System LAN1 DNS  Voicemail Telephony Directory Services System Events SMTP  SMDR VCM  VolP  VolP Security Contaci ¢ | »
4 Operator 9 IPOffice_1
5[ IPOffice 1 ) - LAN Settings] VolP  Network Topology
% System (1)
1 Line (@) 1P Address 0 .10 . 98 . 14
<> Control Unit (4)
@ Extension (40) 1P Mask 255 . 255 . 255 . 12
;ﬂ g::;f‘g) Primary Trans. IP Address o .0 .0 .0
g :horﬁ C?Od)e (60) Firewall Profile <None> v
ervice
o RAS (1) RIP Mode None v
@ Incoming Call Route (14)
9 WAN Port (0) [ Enable NAT
= Directory (0)
£7) Time Profile (0) Number Of DHCP IP Addresses |1
@ Firewall Profile (1) DHCP Mode
@l P Route (2)
. Account Code (0) O Server O Client O Dialln @ Disabled Advanced
% License (31)
@ Tunnel (0)
&; User Rights (9)
@ Auto Attendant (0) oK Cancel Help
o
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The VoIP tab as shown in the screenshot on the next page was configured with following settings:

e Check the SIP Trunks Enable to enable the configuration of SIP Trunk connecting to the
TalkTalk Business system

o Verify Keepalives to select Scope as RTP-RTCP with Periodic timeout 60 and select
Initial keepalives as Enabled

e All other parameters should be set according to customer requirements
e Click OK to submit the changes

=4 IPOffice_1* v

System LAN1 |[LAN2| DNS  Voicemail Telephony Directory Services System Events SMTP SMDR VCM  VolP

VolIP Security Contact Center
LAN Settings Network Topology

H.323 Gatekeeper Enable

[] Auto-create Extension Auto-create User [] H.323 Remote Extension Enable

H.323 Signaling over TLS Disabled v

SIP Trunks Enable

SIP Registrar Enable
[] Auto-create Extension/User

1720 =

[[] SIP Remote Extension Enable
SIP Domain Name [10.1098.14 |

SIP Registrar FQDN \

ubP UDP Port 5060 g 6 s
Layer 4 Protocol TCP TCP Port  |5060 = 2
TLS TLSPort 5061 = 5061 =
Challenge Expiration Time (sec) 10 =
RTP
Port Number Range
Minimum 46750 = Maximum 50750 =
Port Number Range (NAT)
Minimum 46750 < Maximum 50750 S

[] Enable RTCP Menitoring on Port 5005

RTCP collector IP address for phones Y 0 0 0
Keepalives
Scope RTP-RTCP ~ | Periodic timeout 60
Initial keepalives Enabled v

DiffServ Settings

B8 > DSCP(Hex) B8 < Video DSCP (Hex) FC 3 DSCP Mask (Hex) (88 > SIG DSCP (Hex)

46 = nscp 46 21 Viden DSCP 63 =l DSCP Mack 34 2l SIG NScP 3

OK Cancel Help

Figure 6 - Avaya IP Office LAN2 VoIP
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On the Network Topology tab in the Details Pane, configure the following parameters:

e Select the Firewall/NAT Type from the pull-down menu that matches the network
configuration. No firewall or network address translation (NAT) device was used in the
compliance test as shown in Figure 1, so the parameter was set to Open Internet. With this
configuration, STUN Server will not be used

e Set the Binding Refresh Time (sec) to 0. This value is used as one input to determine the
frequency at which Avaya IP Office will send SIP OPTION messages to service provider to
keep the connection alive. Note: As Avaya IP Office design, if no SIP_OPTIONS_PERIOD
parameter is defined and the Binding Refresh Time is 0, then the default value of 300
seconds is used.

e Set Public IP Address to the IP address of the Avaya IP Office LAN2 port

e Set Public Port for UDP as 5060 (For SIP Trunk connecting to TalkTalk Business)

e All other parameters should be set according to customer requirements

e Click OK to submit the changes

=g IPOffice_1* | v

System LAN1 DNS  Voicemail Telephony Directory Services System Events SMTP SMDR VCM  VolP  VolP Security Contact Center

LAN Settings VolP | Network Topology

Network Topology Discovery

STUN Server Address [0.000 STUN Port 3478 =
Firewall/NAT Type Open Internet v
Binding Refresh Time (sec) 0 =
Public IP Address 10 10 %8 14 Run STUN Cancel
Public Port
upp 5060 =
TCp 5060 =
TLS 5061 <

[] Run STUN on startup

oK Cancel Help

Figure 7 - Avaya IP Office LAN2 Network Topology

Note: In the compliance test, the LAN1 interface was used to connect the Avaya IP Office to the
enterprise site IP network (private network). The LAN1 interface configuration is not directly
relevant to the interface with the TalkTalk Business SIP Trunk Service, and therefore is not
described in these Application Notes.
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5.4. System Telephony Settings

Navigate to IPOffice_1 - System (1) in the Navigation and Group Panes (not shown) and then
navigate to the Telephony - Telephony tab in the Details Pane. Choose the Companding Law
typical for the enterprise location. For United Kingdom, A-Law is used. Uncheck the Inhibit Off-
Switch Forward/Transfer box to allow off-net call forwarding and call transfers to the PSTN via
the service provider across the SIP trunk. Set Hold Timeout (sec) to a valid number. Set Default
Name Priority to Favor Trunk. Defaults were used for all other settings. Click OK to submit the

changes.

-

= IPOffice_1

s / v

Telephony  Park & Page Tones & Music Ring Tones SM

Analogue Extensions

Default Outside Call Sequence Normal
Default Inside Call Sequence Ring Type 1
Default Ring Back Sequence Ring Type 2
Restrict Analogue Extension Ringer Voltage [l

Dial Delay Time (sec) 4 =

Dial Delay Count 0 =

Default No Answer Time (sec) 135 &

Hold Timeout (sec) 3600 3

Park Timeout (sec) 300 5

Ring Delay (sec) 5 S

Call Priority Promotion Time (sec) Disabled S

Default Currency usD v

Default Name Priority Favor Trunk ~

Media Connection Preservation Enabled A

Phone Failback Automatic ~

Login Code Complexity
Enforcement
Minimum length 4 :
Complexity

CallLog TUI

v

System LAN1 LAN2 DNS  Voicemail |Telephony | Directory Services System Events SMTP  SMDR VCM  VolP  VolP Security Conta ¢ | *

Companding Law 2
Switch Line

O U-Law U-Law Line

@ A-Law @ A-Law Line

[] DSS Status
[] Auto Held
Dial By Name

Show Account Code

ll:] Inhibit Off-Switch Forward/Transfer

[] Restrict Network Interconnect
Include location specific information
Drop External Only Impromptu Conference
[] Visually Differentiate External Call
[[] Unsupervised Analog Trunk Disconnect Handling
High Quality Conferencing
Digital/Analogue Auto Create User
Directory Overrides Barring

[] Advertise Callee State To Internal Callers

v

OK Cancel

Figure 8 - Avaya IP Office Telephony
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5.5. System VolIP Settings

Navigate to IPOffice_1 - System (1) in the Navigation and Group Panes and then navigate to the
VolIP tab in the Details Pane. Leave the RFC2833 Default Payload as default of 101. Select codec
G.711 ALAW 64K and G.711 ULAW 64K which TalkTalk Business supports. Click OK to
submit the changes.

IP Offices !

System

= IPOffice_1 ( v | -

R BOOTP (5)

4 Operator (3)
7 Line (3)
“= Control Unit (4)
& Extension (46)
§ User@2)
% Group (1)
8% Short Code (59)
@ Service (0)
o RAS (1)
Q Incoming Call Route (25)
2 WAN Port (0)
#= Directory (0)
£ Time Profile (0)
@ Firewall Profile (1)
Ell P Route (2)
@ Account Code (0)
% License (31)
& Tunnel (0)
a; User Rights (9)
8 Auto Attendant (0)
¢ ARS (1)
55 Location (0)

Name

% IPOffice_1

System LAN1 LAN2 DNS  Voicemail Telephony Directory Services System Events SMTP SMDR VCM VolP Security Contay ¢ | *
Ignore DTMF Mismatch For Phones
Allow Direct Media Within NAT Location [

RFC2833 Default Payload 101

Available Codecs Default Codec Selection
Unused Selected

M G711 ULAW bk sas || G711 ALAW 64K

i G.711 ALAW 64K G.711 ULAW 64K

0 6.722 64K G.729(a) 8K CS-ACELP

[ 6.729(a) & CS-ACELP 6.723.1 6K3 MP-MLQ

|4 6.723.1 6k3 MP-MLQ <<<
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5.6. Administer SIP Line

A SIP Line is needed to establish the SIP connection between Avaya IP Office and the TalkTalk
Business system. The recommended method for configuring a SIP Line is to use the template
associated with these Application Notes. The template is an .xml file that can be used by Avaya IP
Office Manager to create a SIP Line. Follow the steps in Section 5.6.1 to create the SIP Line from
the template.

Some items relevant to a specific customer environment are not included in the template or may
need to be updated after the SIP Line is created. Examples include the following:

e |P addresses

e SIP Credentials (if applicable)

e SIP URI entries

e Setting of the Use Network Topology Info field on the Transport tab

Therefore, it is important that the SIP Line configuration be reviewed and updated if necessary after
the SIP Line is created via the template. The resulting SIP Line data can be verified against the
manual configuration shown in Section 5.6.2.

Also, the following SIP Line settings are not supported on Basic Edition:
e SIP Line — Originator number for forwarded and twinning calls
e Transport — Second Explicit DNS Server
e SIP Credentials — Registration Required
e SIP Advanced Engineering

Alternatively, a SIP Line can be created manually. To do so, right-click Line in the Navigation Pane
and select New - SIP Line. Then, follow the steps outlined in Section 5.6.2. For the compliance
test, SIP Line 17 was used as trunk for both outgoing and incoming calls.
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5.6.1. Create S

IP Line from Template

1. Create a new folder in the computer where Avaya IP Office Manager is installed (e.g., C:\
TalkTalk Business\Template). Copy the template file (TTB-IPO10.xml) to this folder.

2. Create the SIP Trunk from the template: Right-click on Line in the Navigation Pane, then
navigate to New from Template - Open from file.

IP Offices Line =
g R BOOTP (5) Line Number  Line Type PRI 24 Line Channels
47 Operator (3) PRI 24
=% IPOffice 3 '
..... iy ice ] New " Line Number
..... T_‘léﬁ]x Gik Chrl+X Card
...... = Con
..... & Exte| 52 Copy Ctrl+C Port
% g:: . Paste Ctrl+V Sunich Type
7< Delete Ctrl+Del
""" 8% Sho " _ Send Service Messages
..... @ Send o Validate
..... % RAS Cannect ok Cirl«T Channel Allocation
..... Inc
..... 157 WARI ] New from Template » | Open from file
..... 2 Direl[ 7] Show| Add 'Not end-to-end ISDN'
..... £ Tim owInGroups Information Element
""" % IF;[;\ Customize Columns... progress Rep|acement
_____ am Acc Change Unlver's‘al PRI Card Line Type » Send Redirecting Number
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3. Select the Template Files (*.xml) and select the copied template from step 1 at IP Office
template directory C:\ TalkTalk Business\Template\. Click Open button to create a SIP
line from template.

IP Offices | Line =) PRI 24 (Universal) - Line 1
-& BOOTP (5) Line Number  Line Type PRI 24 Line Channels
4% Operator (3) PRI 24
- \”:?fsf;:;; 2 1 PRI 24 (Universal) Line Number 01 Line SubType PRI
1 Line 3) 2 PRI 24 (Universal) || Card
= Control Unit (4) SIP Li i
4 Extension (46) 1S Port 9 Admin In
§ User@) %" Open x
--ia% Group (1)
9% Short Code (59) - v N > ThisPC » 0OS(C:) > TalkTalk Business > Template v O Search Template P
B Service (0)
ollg RAS (1) Organize v New folder v [N o
> e Incoming Call Route (25) A
£ WAN Port (0) SBCE & Name Date modified Type Size
{‘: ?:::;Z}E?e) © ¢@ OneDrive ;‘ 5/9/2017 10:07 AM XML Document 4KB
@ Firewall Profile (1) )
Hll 1P Route (2) & This PC
- Account Code (0) [ Desktop
% License (31) .
@& Tunnel (0) =] Documents
~§3 User Rights (9) & Downloads
-igl Auto Attendant (0) . 5
“¢ ARS (1) ) Music 7
- Location (0) = Pictures n
-8 Authorization Code (0) X H
Videos ]
- 0S(C)
= DATAPART1 (D:)
s RECOVERY (E:)
=¥ Network v
File name: | TTB-IPO10.xml vl | Template Files (*xml) 2
Figure 11 — Create SIP Line from IP Office Template Directory
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A pop-up window below will appear stating success (or failure). Then click OK to continue.

Template Provisicning X

0 New SIP Trunk created successfully using selected template,

Figure 12 — Create SIP Line from Template successfully

4. Once the SIP Line is created, verify the configuration of the SIP Line with the configuration
shown in Section 5.6.2.
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5.6.2. Create SIP Line Manually
To create a SIP line, begin by navigating to Line in the left Navigation Pane, then right-click in the
Group Pane and select New > SIP Line (not shown).
On the SIP Line tab in the Details Pane, configure the parameters as shown below:
e Select available Line Number, 17 in this case

e Set ITSP Domain Name to TalkTalk Business SIP signaling server IP address. This field is
used to specify the default host part of the SIP URI in the To and R-URI fields for outgoing

calls

e Set Local Domain Name to IP address of Avaya IP Office LAN2 port. This field is used to
specify the default host part of the SIP URI in the From field for outgoing calls
Note: For the user making the call, the user part of the From SIP URI is determined by the
settings of the SIP URI channel record being used to route the call (see SIP URI - Local
URI). For the destination of the call, the user part of the To and R-URI fields are determined
by dial short codes of the form 9N;/N“@192.168.112.10” where N is the user part of the SIP
URI and “@192.168.112.10” can be used to override the host part of the To and R-URI

Check the In Service and Check OOS boxes
Set URI Type to SIP
For Session Timers, set Refresh Method to Re-invite with Timer (sec) to 1200

Set Name Priority to Favor Trunk. As described in Section 5.4, the Default Name

Priority parameter may retain the default Favor Trunk setting, or can be configured to
Favor Directory. As shown below, the default Favor Trunk setting was used in the
reference configuration
e For Redirect and Transfer, set Incoming Supervised REFER and Outgoing Supervised
REFER to Never. Note: TalkTalk Business did not support SIP Refer in the off-net transfer
call during the compliance testing
e Default values may be used for all other parameters
e Click OK to commit then press Ctrl + S to save

IP Offices | Line E7 SIP Line - Line 17 FEC IR
R BOOTP (5) Line Number  Line Type [SIP Line] Transport SIP URI VolP  T38 Fax SIP C SIP Advanced
Oierator(S) PRI24
= !’(1) o1 PRI 24 (Universa 0 [ff | Lne Numb, & Tncsenvice
f’ﬁm -2 PRI 24 (Universal D || | ISP Domain Name [192:168.112.10 || | check oos
#: Ext trol U'(‘:sg‘” SIP Line tocal B N [10108834 \
& Bdension@6)  |_r= ... || |Local Domain Name 1098
§ Userad) ~[7] SiEHine - = Session Timers
% Group (1) ype v
o sh "piodﬂ 9) Eocation Cloud | | Refresh Method Re-in
@D Service (0)
o RAS (1) Timer (sec) 1200
€ Incoming Call Route (25)
£ WAN Port (0)
=& Directory (0) Prefi ‘ |
£ Time Profile (0)
@ Firewall Profile (1) National Prefix ‘ |
E ‘:(’;" :xet(CZ:)de - international Pref [ |
®. License (31) Redirect and Transfer
e Tunnel ) Sl ‘ | R O — ~ =
§3 UserRights (9) Name Priority Favor Trunk v ‘ ‘‘‘‘‘‘ g UpCIVIse ey
i Auto Attendant (0) Outgoing Supervised REFER Never v
RS Descripti
ia.'; i e 0 f e | | Send 302 Moved Temporarily [
#% Authorization Code (0) Outgoing Blind REFER O
£ >
Figure 13 — SIP Line Configuration
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On the Transport tab in the Details Pane, configure the parameters as shown below:

The ITSP Proxy Address was set to the IP address of TalkTalk Business Signaling Server:
192.168.112.10. This is the SIP Proxy IP address used for outgoing SIP calls

In the Network Configuration area, UDP was selected as the Layer 4 Protocol and the Send
Port was set to 5060

The Use Network Topology Info parameter was set to LAN 2. This associates the SIP Line 17
with the parameters in the IPOffice_1 - System (1) > LAN2 - Network Topology tab.
The Listen Port was set to 5060

The Calls Route via Registrar was unchecked as TalkTalk Business did not support the
dynamic Registration on the SIP Trunk

Other parameters retain default values

Click OK to commit then press Ctrl + S to save

= Control Unit (4)
& Extension (46)

§ User(42)

% Group (1)

9% Short Code (59)

@ Service (0)

o RAS (1)

@ Incoming Call Route (25)
9 WAN Port (0)

@& Directory (0)

£ Time Profile (0)

@ Firewall Profile (1)

K@ 1P Route (2)

am Account Code (0)

% License (31)
W& Tunnel (0)
2 UserRights

IP Offices | Line Z SIP Line - Line 17* e B X[ v]«|>
R BOOTP (5) LineNumber  Line Type SIP Line [Transport] SIP URI VolP  T38 Fax SIP Credentials SIP Advanced Engineeri
1% Operator (3) PRI 24
by / - — lnsp Prowy Address [192.168.11210 JI
% System (1)
F[line @) 2 PRI 24 (Universal)

Network Configuration
SIP Line

]

Layer 4 Protocol upP v Send Port 3060

SIP Line

Use Network Topology Info |LAN 2 v

Explicit DNS Server(s) 0 0 0 0 0 0 0 0

Calls Route via Registrar O

Separate Registrar ‘

9 s 2

Figure 14 — SIP Line Transport Configuration

The SIP URI entry must be created to match any DID number assigned to an Avaya IP Office user
and Avaya IP Office will route the calls on this SIP line. Select the SIP URI tab; click the Add
button and the New Channel area will appear at the bottom of the pane (not shown). To edit an
existing entry, click an entry in the list at the top, and click Edit... button. In the example screen on
next page, the previously configured entries are edited.

A SIP URI entry was created that matched any DID number assigned to an Avaya IP Office user.
The entry was created with the parameters shown below:

Set Local URI, Contact, Display Name to Use Internal Data. This setting allows calls on
this line whose SIP URI matches the number set in the SIP tab of any User as shown in
Section 5.8

Set Identity to Use Internal Data and Header to P Asserted ID

For Forwarding And Twinning, set Send Caller ID to Diversion Header

Note: When using twinning feature, the calling party number displayed on the twinned phone
is controlled by (but not necessarily extracted from) Send Caller ID parameter

Set Diversion Header to None

Set Registration to 0: <None>
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e Associate this line with an incoming line group in the Incoming Group field and an
outgoing line group in the Outgoing Group field. This line group number will be used in
defining incoming and outgoing call routes for this line. For the compliance test, a new line
group 17 was defined that only contains this line (line 17)

e Set Max Sessions to the number of simultaneous SIP calls that are allowed using this SIP

URI pattern
e Click OK to submit

the changes

&

SIP Line - Line 17*

k- X[ vl=]|>

SIP

Line Transport|SIP URI| VolP

T38 Fax SIP Credentials SIP Advanced Engineering

URI Groups Local URI  Contact Display Name |dentity Header Originator Number Send Caller ID Diversion Header Creda] Add.. [®
1 17 17  <Internal> <Internal> <Internal> <Internal> PAl Diversion None 0: <Ng
2 17 17 Auto Auto Auto None PAI None None 0: <N Remove
Edit...
Edit URI oK
Local URI IUse Internal Data vl
Cancel
Contact |Use Internal Data vl
Display Name IUse Internal Data v |
Identity
Identity \Use Internal Data v l
Header P Asserted ID S
Forwarding And Twinning
Originator
Number
Send CaliecD Diversion Header ~
Diversion Header ‘None v
Registration 0: <None> b
Incoming Group 17 v
Outgoing Group 17 ~
Max Sessions 50 >
v
Help
Figure 15— SIP Line SIP URI Configuration 1
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Another SIP URI entry was created for testing inbound toll-free. The entry was created with the
parameters shown below:
e Associate this line with an incoming line group in the Incoming Group field. This line group
number will be used in defining incoming call routes for this line.

e Set Max Sessions to the number of simultaneous SIP calls that are allowed using this SIP
URI pattern

e Other parameters retain default values
e Click OK to submit the changes

7 SIP Line - Line 17* of -B X[ vl<]|>
SIP Line Transport SIP URI VoIP  T38 Fax SIP Credentials SIP Advanced Engineering
URl  Groups Local URI  Contact Display Name Identity Header Originator Number Send Caller ID  Diversion Header Credel Add... G
1 17 17  <Internal> <Internal> <Internal> <Internal> PAIl Diversion None 0: <N¢
2 17 [l Auto Auto Auto None PAI None None 0: <Ng Remove
Edit...
Edit URI oK
Local URI |m vl
Cancel
Contact IAuto v}
Display Name IAuto v ’
Identity
Identity 'None v|
Header P Asserted ID 2

Forwarding And Twinning

Originator
Number
Send Caller ID ol S
Diversion Header |None v
Registration 0: <None> v
Incoming Group 17 v ‘
Outgoing Group
I Max Sessions 50 o
v
< >
Help
Figure 16 — SIP Line SIP URI Configuration 2
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Select the VoI P tab to set the VVoice over Internet Protocol parameters of the SIP line. Set the
parameters as shown below:

e The Codec Selection can be selected by choosing Custom from the pull-down menu,
allowing an explicit ordered list of codecs to be specified. The G.711 ALAW and G.711
ULAW codecs are selected. Avaya IP Office supports the codecs, which are sent to the
TalkTalk Business. Check the Re-invite Supported box

e Set Fax Transport Support to G.711 from the pull-down menu. Note: TalkTalk Business
supports only G.711 pass-through mode during the compliance testing

e Setthe DTMF Support to RFC2833 from the pull-down menu. This directs Avaya IP
Office to send DTMF tones using RTP events messages as defined in RFC2833

e Default values may be used for all other parameters

e Click OK to submit the changes

IP Offices | Line Z SIP Line - Line 17* e - v«

& 80OTP (5) Line Number | Line Type SIP Line Transport SIP URI 38 Fax SIP Credentials SIP Advanced Engi
4# Operator (3) PRI 24
“= IPOffice_1 [ VolP Silence Suppression

@ Systeam (1] 1 PRI 24 (Universal)

T Line 3) 2 PRI 24 (Universal) [ Local Hold Music

< Control Unit (4) SIP Line Codec Selection Custom v ‘ i o

g ion (4

: K:rn(j;)n( C iz SLAE lnused Scected [J Codec Lockdown

¢ Group (1) [6.729(a) 8K C5-ACELP RSB G711 ALAW 64K ‘

9% Short Code (59) |6.723.1 6K3 MP-MLQ G.711 ULAW 64K [ Allow Direct Media Path

B Senvice (0) Force direct media with phones

& RAS (1)

@ Incoming Call Route (25) [J PRACK/100rel Supported

£9 WAN Port (0) <<<

=
@ Directory (0) [J G.711 FaxECAN

£ Time Profile (0)
@ Firewall Profile (1)
K@ 1P Route (2)

am Account Code (0)
% License (31)

W& Tunnel (0)
§3 User Rights (9) Fax Transport Support | G.711 v
: ﬁgtsc(%mndam © DTMF Support RFC2833 .
% Location (0) Niedia Secinty Disabled v
% Authorization Code (0)
» 5 Cancel Help

Figure 17 — SIP Line VolP Configuration
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5.7. Outgoing Call Routing — Short Code
The following section describes the Short Code for outgoing calls to TalkTalk Business.

To create a short code, select Short Code in the left Navigation Pane, then right-click in the Group
Pane and select New (not shown). On the Short Code tab in the Details Pane, configure the
parameters for the new short code to be created. The screen below shows the details of the
previously administered “9N;” short code used in the test configuration.

e In the Code field, enter the dial string which will trigger this short code, followed by a semi-
colon. In this case, 9N;, this short code will be invoked when the user dials 9 followed by
any number

e Set Feature to Dial. This is the action that the short code will perform

e Set Telephone Number to N“@192.168.112.10”. This field is used to construct the Request
URI and To headers in the outgoing SIP INVITE message. The value N represents the
number dialed by the user. The host part following the “@” is the TalkTalk Business
signaling server IP address

e Setthe Line Group ID to the Outgoing Group 17 defined on the SIP URI tab on the SIP
Line in Section 5.6.2. This short code will use this line group when placing the outbound call

e Setthe Locale to United Kingdom (UK English)

e Default values may be used for all other parameters

e Click OK to submit the changes

IP Offices

Short Code

7 9N;: Dial*

R BOOTP (5)

i# Operator (3)
“ System (1)
F7 Line (3)

<> Control Unit (4)

& Extension (46)
£ User(@2
ﬁ Group (1)
9x(Short Code (9]
@B Service (0)
o RAS (1)
@ Incoming Call Route (25)
2 WAN Port (0)
@ Directory (0)
£1) Time Profile (0)
@ Firewall Profile (1)
@ 1P Route ()
@ Account Code (0)

Code
Call Park
PX37TNE
Call Pickup Any
%730
Call Pickup Extension
P32 N2
Call Pickup Group
%731
Call Pickup Members
Dial
BXON;
Px*33* N2
Call Steal

Short Code

Code [on;

Feature Dial

[N@12168.112:10"

Telephone Number

Line Group ID [17

Locale United Kingdom (UK English)

Force Account Code O
Force Authorization Code []
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The feature of incoming calls from mobility extension to idle-appearance FNE (Feature Name
Extension) is hosted by Avaya IP Office. The Short Code FNEOO was configured with following

parameters:

e For Code field, enter FNE feature code as FNEQO for dial tone

e Set Feature to FNE Service
e Set Telephone Number to 00

e SetLineGroupIDto0
e Set the Locale to United Kingdom (UK English)
e Default values may be used for other parameters
e Click OK to submit the changes
IP Offices I Short Code 7 FNEOO: FNE Service* ek X|vl=<
& BOOTP (5) Code *|| short Code
5 }:)3) Dial Physical Extension by ID Code ‘FNEOO
% System (1) WXTIINE
T4 Line @) Dial Physical Extension by Nurr || |Fe2tre JNESEvEs
<2 Control Unit (4) =
& Extension (46) 9%70"N# Telephone Number |00
& User(4) Display Mes!
Lo D tecowo  [8
g 9%*SDN Locale United Kingdom (UK English)
o RAS (1) B%7SKN Force Account Code O
@ Incoming Call Route (25) | FNE Service Force Authorization Code [
2 WAN Port (0)
= Directory (0)
£ Time Profile (0) Follow Me Here
@ Firewall Profile (1) 912N
E f::zﬁ:i ((?:;de © Follow Me Here Cancel Cancel Help
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5.8. User

Configure the SIP parameters for each user that will be placing and receiving calls via the SIP Line
defined in Section 5.6. To configure these settings, first select User in the left Navigation Pane, then
select the name of the user to be modified in the center Group Pane. In the example below, the name
of the user is 0304. Select the SIP tab in the Details pane.

The values entered for the SIP Name and Contact fields are used as the user part of the SIP URI in
the From header for outgoing SIP trunk calls. They also allow matching of the SIP URI for incoming
calls without having to enter this number as an explicit SIP URI for the SIP line. The example below
shows the settings for user 0304. The SIP Name and Contact are set to one of the DID numbers
assigned to the enterprise provided by TalkTalk Business. The SIP Display Name (Alias) parameter
can optionally be configured with a descriptive name. If all calls involving this user and a SIP Line
should be considered private, then the Anonymous box may be checked to withhold the user’s
information from the network.

IP Offices | User Z 0304: 0304* -8 X vl<|> @
A gOOTf (5’3) Name Bdension. | P rarding | Dial I | Vaice Recording | Button Programming | Ment Programming | Mobiliy | Group Membership | AnTouncements Persona « | »
i Qperator Power User
- ’11(1) SIP Name 03305550304 |

17 Line @) 0305 0305 SIP Display Name (Alias) [H323-0304 |

<> Control Unit (4) §-0306 0306 & |03305’50304 ‘

& Extension (46) 3 ontact 5.

i) s o

$5 Short Cade 9 0300 0309

D Senvice (0) §-0310 0310

. RAS (1) pgRemoteMana...

$ Incoming Call Route (25) ks S

€9 WAN Port (0) Cancel Help

2= Director (0) —

Figure 20 — User Configuration
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One of the H.323 IP Deskphones at the enterprise site uses the Mobile Twinning feature. The
following screen shows the Mobility tab for User 0304. The Mobility Features and Mobile
Twinning boxes are checked. The Twinned Mobile Number field is configured with the number to
dial to reach the twinned mobile telephone, in this case 9001613XXX5096. Check Mobile Call
Control to allow incoming calls from mobility extension to access FNEQO (defined in Section 5.7).

Other options can be set according to customer requirements.

7 0304: 0304* - X[ v <|> @

Forwarding DialIn Voice Recording Button Programming Menu Programming |Mobility| Group Membership Announcements SIP Persona ¢ | *

[ Internal Twinning

<None>
1
Twin Bridge Appearances
Twin Coverage Appearances
Twin Line Appearances
[E Mobility Features|

Mobile Twinning

Twinned Mobile Number ’ 9001613XXX5096 I
(including dial access code)

Twinning Time Profile <None>
Mobile Dial Delay (sec) ’2 I
Mobile Answer Guard (sec) |0 =

[] Hunt group calls eligible for mobile twinning
[ Forwarded calls eligible for mobile twinning
[[] Twin When Logged Out

[[] one-X Mobile Client

Mobile Call Control

[] Mobile Callback

Cancel Help

Figure 21 — Mobility Configuration for User
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5.9. Incoming Call Route

An Incoming Call Route maps an inbound DID number on a specific line to an internal extension.
This procedure should be repeated for each DID number provided by service provider. To create an
incoming call route, select Incoming Call Route in the left Navigation Pane, then right-click in the
center Group Pane and select New (not shown). On the Standard tab of the Details Pane, enter the
parameters as shown below:

o Set the Bearer Capability to Any Voice

e Setthe Line Group ID to the Incoming Group 17 defined on the SIP URI tab on the SIP

Line in Section 5.6.2
e Set the Incoming Number to the incoming DID number on which this route should match.
e Default values can be used for all other fields

IP Offices | Incoming Call Route = 17 03305550304 ek - el s
& B0OTP (5) Line Group ID  Incoming Number || [Standard| Voice Recording ~ Destinations
i g‘(’;’:‘°‘1(3) 17 03303550310
L S (34 03305550309 -

1 Line ) 17 03305550308 Bearer Capability Any Voice v

% Control Unit (4) @17 03305550307 Line Group ID [i7 v‘
& Extension (46) Q17 03305550306 r
;ﬁ gser (4(21) @17 03305550305 Incoming Number |03305550304 \

roup (1) é o,

9 Short Code (59) 17 03305550304 Incoming Sub Address [ |
@ Service (0) 0 >
X s &0 Incoming CLI \ |
@ Incoming Call Route (25) Locale United Kingdom (UK English) v
2 WAN Port (0)
= Directory (0) Priority 1- Low v
£ Time Profile (0)
@ Firewall Profile (1) Tag \ |
@l 1P Route (2)
@m Account Code (0) Hold Music Source System Source v
% License (31) N
& Tunnel (0) Ring Tone Override [None v‘
&; User Rights (9)
@8 Auto Attendant (0)

‘¢ ARS (1) % n Cancel Help
B loction (0)

Figure 22 — Incoming Call Route Configuration

On the Destination tab, select the destination extension from the pull-down menu of the Destination
field. In this example, incoming calls to 03305550304 on line 17 are routed to Destination 0304
0304 as shown in the following screenshot:

IP Offices | Incoming Call Route 7 17 03305550304 ef - X|lwvl=<|>
R BOOTP (5) Line Group ID Incoming Number || gtandard  Voice Recording
4 Operator (3)
pith = @ 98008708392 TimeProfile Destination Fallback Extension
. (1) o 03305550310 = AT
= stem
e Q1 03305550300 2 2Lt Yale z -
= Control Unit (4 1 03305550308
& Extension (46) @17 03305550307
§ User@d Q17 03305550306
% Group (1) Q17 03305550305
o o Coce () ) r—
@B Service (0) ! —
o RAS (1)
@ lincoming Call Route (25)

£9 WAN Port (0)
- Directory (0) Cancel Help

£ Time Drofile (0)

Figure 23 — Incoming Call Route for Destination 0304
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For Feature Name Extension Service testing purpose, the incoming calls to DID number
03305550309 were configured to access FNEOO. The Destination was appropriately defined as
FNEOO as shown in the following screenshot:

IP Offices | Incoming Call Route 7 17 03305550309" ef -8 X|v|<|>
R BOOTP (5) Line Group ID  Incoming Number Destination Standard Voice Recording
5 f.“/) g:: gzgﬁzsgii?; 3304 :jo“l TimeProfile Destination Fallback Extension
= System (1) - S , |Default Value [Frveod] v v
4 Line @) @7 03305550309 FNEOD|
< Control Unit (4) @17 03305550308 2090308
& Extension (46) @17 03305550307 2010307
§ User@ @17 03305550306 0306 0306
?,; ?&‘Zi"c(lie & Q17 03305550305 0305 0305
@ semice () @17 03305550304 0304 0304
o RAS (1
@/incoming Cal Route 25
€2 WAN Port (0)
@& Directory (0)
£ Time Profile (0) Cancel Help
@ Firewall Profile (1)

Figure 24 — Incoming Call Route for Destination FNE

For Voice Mail testing purpose, the incoming calls to DID number 03305550310 were configured to
access VoiceMail. The Destination was appropriately defined as VoiceMail as shown in the
following screenshot:

IP Offices | Incoming Call Route 2 17 03305550310 [ X|lwvl=z|>
K BOOTP (5) Line Group ID  Incoming Number Destination Standard Voice Recording Destinations
¢ Operator (3) 17 08008708392 0304 0304 - - - -
S ﬁ o b Tt TimeProfile Destination Fallback Extension
= System (1) @17 03305550300 ENEOO »  |Default Value [VoiceMail v o
T_" é'::t(i)l ki 17 03305550308 2090308
& Extension (46) @17 03305550307 2010307
§ User@) Q@17 03305550306 0306 0306
2% Group (1) @17 03305550305 0305 0305
% Short Code (59) D17 03305550304 0304 0304
) SENICE ©
o RAS (1
@ incoming o] Concel | | Hep
£ WAN Port (0)

Figure 25 — Incoming Call Route for Destination Voice Malil

For inbound toll-free testing purpose, the incoming calls to 08008708392 are routed to Avaya IP
Office and Avaya IP Office is configured to terminate the call at extension 0304. The Destination
was appropriately defined as 0304 0304 as shown in the following screenshot:

IP Offices | Incoming Call Route 7 17 08008708392 ef - Xlvli<|=
R BOOTP (5) Line Group ID  Incoming Number Destination Standard Voice Recording | Destinations
4# Operator (3)
“w/[IPOffice_1 ng giggzgiz?; 3304 ﬁjml} TimeProfile Destination Fallback Extension
= 7 5! loiceMai
f:_‘ Ely:ir;) M @17 03305550309 FNECO .+ |Default Value 0304 0304] v v
% Control Unit (4) @17 03305550308 2090308
& Extension (46) @17 03305550307 2010307
§ User(@) @17 03305550306 0306 0306
ﬁ ;"WP c(‘L & 17 03305550305 0305 0305
ort Code o
@ Service (0) 017 03305550304 0304 0304
ok RAS (1)
@ [Incoming Call Route (25 Cancel Help
£9 WAN Port (0)

Figure 26 — Incoming Call Route for Inbound Toll Free
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5.10. Save Configuration

Navigate to File > Save Configuration in the menu bar at the top of the screen to save the
configuration performed in the preceding sections.
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6. TalkTalk Business SIP Trunk Configuration

TalkTalk Business is responsible for the configuration of TalkTalk Business SIP Trunk Service. The
customer must provide the IP address used to reach the Avaya IP Office LAN2 port at the enterprise.
TalkTalk Business will provide the customer necessary information to configure the SIP connection
between Avaya IP Office and TalkTalk Business. The provided information from TalkTalk Business
includes:

e [P address and port number used for signaling or media servers through any security devices

e DID numbers

o TalkTalk Business SIP Trunk Specification (If applicable)
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7. Verification Steps
The following steps may be used to verify the configuration:

e Use the Avaya IP Office System Status application to verify the state of the SIP connection.
Launch the application from Start - Programs - IP Office - System Status on the PC
where Avaya IP Office Manager was installed. Select the SIP Line of interest from the left
pane. On the Status tab in the right pane, verify the Current State for each channel (The
following screen-shot shows 2 active calls at the present time).

S Avaya IP Office System Status - IPOffice_1 (10.10.98.14) - IP500 V2 10.0.0.3.0 build 5

AVAYA

Help Snapshot LogOff Exit About

System

Status | Utilization Summary Alarms

Line Service State:

Peer Domain Name:
Resolved Address:

Line Number:

Number of Channels in Use:
Administered Compression:

Number of Administered Channels:

IP Office System Status

In Service
192.168.112.10
192.168.112.10
17

100

2

G711A, G711 Mu

SIP Trunk Summary

Enable Faststart: Off
Silence Suppression: off
Media Stream: RTP
Layer 4 Protocol: UDP
SIP Trunk Channel Licenses: 128 . 29
SIP Trunk Channel Licenses in Use: 2
SIP Device Features:
aller IDor  Other Party on Ca Direction o
b a Add p Dialed Dig a
1 1 8 Connected || 00:00:10 |192.168.112.10 |G711A | RTPRelay [011161396... Extn 0304, 0304 Incoming "
2 0 9 Connected || 00:00:03 |192.168.112.10 |G711A | RTP Relay Extn 0306, 0306 Outgoing
3 Idle 00:00:43
4 Idie 03:25:21
5 Idie 03:25:21
3 Idle 03:25:21
7 Idle 03:25:21
8 Idie 03:25:21
9 Idle 03:25:21
Trace Trace All Pause Ping Call Details Graceful Shutdown Force Out of Service Print... Save As...
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e Use the Avaya IP Office System Status application to verify that no alarms are active on the
SIP line. Launch the application from Start = Programs -> IP Office - System Status on
the PC where Avaya IP Office Manager was installed. Select Alarm - Trunks to verify that
no alarms are active on the SIP line.

b )] Avaya IP Office System Status - IPOffice_1 (10.10.98.14) - IP500 V2 10.0.0.3.0 build 5 — X

AVAYA IP Office System Status

Help Snapshot LogOff Exit About

System

B & Alarms (5) Select a line to display the alarm information
Configuration (0)
i Service (1)

Module / Slot / Type Port Number / Address / Domain
3 1 Slot: 1 1 2
= ra & 2 Slot: 1 2 2

& Line: 1(2) iz SIP 192.168.112.10 0]

& Line:2(2)
Line: 17 (0)

Figure 28 — SIP Trunk alarm

e Verify that a phone connected to the PSTN can successfully place a call to Avaya IP Office
with two-way audio.

e Verify that a phone connected to Avaya IP Office can successfully place a call to the PSTN
with two-way audio.

e Use a network sniffing tool (e.g., Wireshark) to monitor the SIP signaling between the
enterprise and TalkTalk Business. The sniffer traces are captured at the LANZ2 port interface
of the Avaya IP Office.
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8. Conclusion

TalkTalk Business passed compliance testing excepting the limitation in Section 2.2. These
Application Notes describe the procedures required to configure the SIP connections between Avaya
IP Office and the TalkTalk Business system as shown in Figure 1.

9. Additional References

[1] Administering Avaya IP Office Platform with Manager, Release 10.0, September 2016.

[2] Deploying Avaya IP Office™ Platform Solution, Release 10.0, 15-601042 Issue 31q, 06
February 2017

[3] Using Avaya Communicator for Web, Release 1.0, Issue 1.0.6, May 2016.

[4] Using Avaya Communicator for Windows on IP Office, Release 10.0, August 2016.

Product documentation for Avaya products may be found at: http://support.avaya.com. Additional IP
Office documentation can be found at:
http://marketingtools.avaya.com/knowledgebase/ipoffice/general/rss2html.php? XMLFILE=manuals.
XmMI&TEMPLATE=pdf feed template.html

Product documentation for TalkTalk Business SIP Trunk may be found at:
https://www.talktalkbusiness.co.uk/products/voice
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